Table of Contents

Introduction ........................................................................................................................................ 1
About QualiPHY ......................................................................................................................... 1
About QPHY-10GBASE-KR ...................................................................................................... 1
Required Equipment .................................................................................................................. 1
Remote Host Computer Requirements .................................................................................. 2

Installation and Setup ............................................................................................................... 3
Install Base Application ........................................................................................................... 3
Activate Components .............................................................................................................. 3
Set Up Dual Monitor Display ............................................................................................... 3
Set Up Remote Control ........................................................................................................... 4
    Configure Oscilloscope for Remote Control .................................................................. 4
    Add Connection to QualiPHY ....................................................................................... 4
    Select Connection .......................................................................................................... 4

Using QualiPHY ....................................................................................................................... 5
Accessing the Software ........................................................................................................... 5
General Setup .......................................................................................................................... 6
    Connection tab ............................................................................................................. 6
    Session Info tab .......................................................................................................... 6
    Report tab .................................................................................................................... 6
    Advanced tab .............................................................................................................. 6
    About tab ...................................................................................................................... 6

Customizing QualiPHY .......................................................................................................... 10
Copy Configuration ................................................................................................................ 10
Select Tests ............................................................................................................................. 10
Edit Variables ......................................................................................................................... 11
Edit Test Limits ...................................................................................................................... 12

X-Replay Mode ...................................................................................................................... 13

QPHY-10GBASE-KR Testing .................................................................................................... 14
Test Preparation ....................................................................................................................... 14
QPHY-10GBASE-KR Test Configurations ............................................................................. 14
    DEMO Mode ................................................................................................................ 14
    Run Live with Pauses, Single Ended Inputs on row A ................................................. 14
QPHY-10GBASE-KR Test Descriptions ............................................................................... 15
    Jitter: Tj, Rj, Dj, DCD & BitRate ................................................................................ 15
    Voltage Measurements Single Ended – on 0101 ....................................................... 15
    Voltage Measurements Differential – on 0101 ......................................................... 15
    Transition Time Test ..................................................................................................... 15
    TX Output Waveform Tests .......................................................................................... 15
QPHY-10GBASE-KR Variables ............................................................................................... 16
    Specific to Jitter and Voltage Tests ............................................................................ 16
QPHY-10GBASE-KR Limit Sets ............................................................................................... 17

Appendix A: Manual Deskewing Procedures .......................................................................... 18
Cable Deskewing Using the Fast Edge Output ................................................................... 18
Cable Deskewing Without Using the Fast Edge Output ................................................... 21
Table of Figures
Figure 1. QualiPHY framework dialog and Standard selection menu .................................................................5
Figure 2. The Test Report Cover, Summary Table and Details pages ........................................................................9
Figure 3. Variable Setup tab .....................................................................................................................................11
Figure 4. Limits Manager .........................................................................................................................................12
Figure 5. X-Replay Mode window ............................................................................................................................13

About This Manual
This manual assumes that you are familiar with using an oscilloscope—in particular the Teledyne LeCroy oscilloscope that will be used with QualiPHY—and that you have purchased the QPHY-10GBASE-KR software option. Some of the images in this manual may show QualiPHY products other than QPHY-10GBASE-KR, or were captured using different model oscilloscopes, as they are meant to illustrate general concepts only. Rest assured that while the user interface may look different from yours, the functionality is identical.
Introduction

About QualiPHY
QualiPHY is highly automated compliance test software meant to help you develop and validate the PHY (physical-electrical) layer of a device, in accordance with the official documents published by the applicable standards organizations and special interest groups (SIGs). You can additionally set custom variables and limits to test compliance to internal standards.

QualiPHY is composed of a “framework” application that enables the configuration and control of separate tests for each standard through a common user interface. Features include:

- **Multiple Data Source Capability**: Connect to your X-Stream oscilloscope via LAN or other interfaces.
- **User-Defined Test Limits**: Parameter interconnect losses can be factored into the parametric results.
- **Flexible Test Results Reporting** that includes XML Test Record Generation. Understand a device performance distribution, or obtain process related information from the devices under test.

About QPHY-10GBASE-KR
QPHY-10GBASE-KR is an automated test package performing all the normative, real-time oscilloscope tests for sources in accordance with Clause 72 of IEEE 802.3ap-2007.

The software can be run on any Teledyne LeCroy oscilloscope with at least 16 GHz bandwidth.

Required Equipment
Teledyne LeCroy real-time oscilloscope, ≥ 16 GHz BW, installed with:

- XStreamDSO v.7.3.x.x minimum* with an activated QPHY-10GBASE-KR option key
- QualiPHY software v.7.3.x.x minimum with an activated QPHY-10GBASE-KR component
- SDAII or SDAIII software option (SDAIII standard on SDA Zi and DDA Zi model oscilloscopes)
Remote Host Computer Requirements

Usually, the oscilloscope is the host computer for the QualiPHY software, and all models that meet the acquisition requirements will also meet the host system requirements. However, if you wish to run the QualiPHY software from a remote computer, these minimum requirements apply:

- Operating System:
  - Windows 10 Professional
  - Windows 7 Professional
- 1 GHz or faster processor
- 1 GB (32-bit) or 2 GB (64-bit) of RAM
- Ethernet (LAN) network capability
- Hard Drive:
  - At least 100 MB free to install the framework application
  - Up to 2 GB per standard installed to store the log database (each database grows from a few MB to a maximum of 2 GB)

See [Set Up Remote Control](#) for configuration instructions.
Installation and Setup

QualiPHY is a Windows-based application that can be configured with one or more serial data compliance components. Each compliance component is purchased as a software option.

Install Base Application

Download the latest version of the QualiPHY software from:
teledynelecroy.com/support/softwaredownload under Oscilloscope Downloads > Software Utilities

If the oscilloscope is not connected to the Internet, copy the installer onto a USB memory stick, then transfer it to the oscilloscope desktop or a folder on a D:\ drive to execute it.

Run QualiPHYInstaller.exe and follow the installer prompts. Choose all the components you plan to activate. If you omit any components now, you will need to update the installation to activate them later.

By default, the oscilloscope appears as local host when QualiPHY is executed on the oscilloscope. Follow the steps under Add Connection to QualiPHY to check that the IP address is 127.0.0.1.

Activate Components

The serial data compliance components are factory installed as part of the main application in your oscilloscope and are individually activated through the use of an alphanumeric code uniquely matched to the oscilloscope’s serial number. This option key code is what is delivered when purchasing a software option.

To activate an option on the oscilloscope:

1. From the menu bar, choose Utilities > Utilities Setup.
2. On the Options tab, click Add Key.
3. Use the Virtual Keyboard to Enter Option Key, then click OK.
   - If activation is successful, the key code now appears in the list of Installed Option Keys.
4. Restart the oscilloscope application by choosing File > Exit, then double-clicking the Start DSO icon on the desktop.

Set Up Dual Monitor Display

Teledyne LeCroy recommends running QualiPHY on an oscilloscope equipped with Dual Monitor Display capability. This allows the waveform and measurements to be shown on the oscilloscope LCD display while the QualiPHY application and test results are displayed on a second monitor.

See the oscilloscope Operator’s Manual or Getting Started Manual for instructions on setting up dual monitor display.
Set Up Remote Control
QualiPHY software can be executed from a remote host computer, controlling the oscilloscope through a LAN Connection. To set up remote control:

- The oscilloscope must be connected to a LAN and assigned an IP address (fixed or dynamic).
- The host computer must be on the same subnet as the oscilloscope.

Configure Oscilloscope for Remote Control
1. From the menu bar, choose Utilities  Utilities Setup...
2. Open the Remote tab and set Remote Control to TCP/IP.
3. Verify that the oscilloscope shows an IP address.

Add Connection to QualiPHY
1. On the host PC, download and run QualiPHYInstaller.exe.
2. Start QualiPHY and click the General Setup button.
3. On the Connection tab, click Scope Selector.
4. Click Add and choose the connection type. Enter the oscilloscope IP address from Step 3 above. Click OK.
5. When the oscilloscope is properly detected, it appears on the Scope Selector dialog. Select the connection, and click OK.
   QualiPHY is now ready to control the oscilloscope.

Select Connection
Multiple oscilloscopes may be accessible to a single remote host. In that case, go to General Setup and use the Scope Selector at the start of the QualiPHY session to choose the correct connection.

QualiPHY tests the oscilloscope connection when starting a test. The system warns you if there is a connection problem.
Using QualiPHY

This section provides an overview of the QualiPHY user interface and general procedures. For detailed information about the QPHY-10GBASE-KR software option, see QPHY-10GBASE-KR Testing.

Accessing the Software

Once QualiPHY is installed and activated, it can be accessed from the oscilloscope menu bar by choosing Analysis > QualiPHY, or by double-clicking the QualiPHY desktop icon on a remote computer.

The QualiPHY framework dialog illustrates the overall software flow, from general set up through running individual compliance tests. Work from left to right, making all desired settings on each sub-dialog.

![Figure 1. QualiPHY framework dialog and Standard selection menu](image)

The sub-dialogs are organized into tabs each containing configuration controls related to that part of the process. These are described in more detail in the following sections.

If Pause on Failure is checked, QualiPHY prompts to retry a measure whenever a test fails.

Report Generator launches the manual report generator dialog.

The Exit button at the bottom of the framework dialog closes the QualiPHY application.
General Setup
The first sub-dialog contains general system settings. These remain in effect for each session, regardless of Standard, until changed.

Connection tab
Shows IP Address of the test oscilloscope (local host 127.0.0.1 if QualiPHY is run from the oscilloscope). The Scope Selector allows you to choose the oscilloscope used for testing when several are connected to the QualiPHY installation. See Set Up Remote Control for details.

Session Info tab
Optional information about the test session that may be added to reports, such as: Operator Name, Device Under Test (DUT), Temperature (in °C) of the test location, and any additional Comments. There is also an option to Append Results or Replace Results when continuing a previous session. To optimize report generation, enter at least a DUT name at the beginning of each session.

Report tab
Settings related to automatic report generation. Choose:

- Reporting behavior of:
  - “Ask to generate a report after tests,” where you’ll be prompted to create a new file for each set of test results.
  - “Never generate a report after tests,” where you’ll need to manually execute the Report Generator to create a report.
  - “Always generate a report after tests,” to autogenerate a report of the latest test results.

- Default report output type of XML, HTML, or PDF.
- A generic Output file name, including the full path to the report output folder.
- Optionally, check Allow style sheet selection in Report Generator to enable the use of a custom .xslt when generating reports. The path to the .xslt is entered on the Report Generator dialog.

Report Generator launches the Report Generator dialog, which contains the same settings as the Report tab, only applied to individual reports.

Advanced tab
This tab launches the X-Replay Mode dialog. See X-Replay Mode.

About tab
Information about your QualiPHY installation.
QualiPHY Test Process

Once general system settings are in place, these are the steps for running test sessions.

Set Up Test Session


2. Access the QualiPHY software to display the framework dialog.

3. If running QualiPHY remotely, click General Setup and open the Scope Selector to select the correct oscilloscope connection.

4. If you have more than one component activated, click Standard and select the desired standard to test against. Otherwise, your one activated component will appear as the default selection.

   **Note**: Although all the QualiPHY components appear on this dialog, only those selected when installing QualiPHY are enabled for selection.

5. Click the Configuration button and select the test configuration to run. These pre-loaded configurations are set up to run all the tests required for compliance and provide a quick, easy way to begin compliance testing. See QPHY-10GBASE-KR Test Configurations for a description of your configurations.

   You can also create custom configurations for internal compliance tests by copying and modifying the pre-loaded configurations. See Customizing QualiPHY for details.

6. Close the Edit/View Configuration dialog to return to the framework dialog.
Run Tests

1. On the framework dialog, click Start to begin testing.
   
   When tests are in progress, this button changes to Stop. Click it at any time to stop the test in process. You'll be able to resume from the point of termination or from the beginning of the test.

2. Follow the pop-up window prompts. QualiPHY guides you step-by-step through each of the tests described in the standard specification, including diagrams of the connection to the DUT for each required test mode.

3. When all tests are successfully completed, both progress bars on the framework dialog are completely green and the message “All tests completed successfully” appears. If problems are encountered, you'll be offered options to:
   
   - **Retry** the test from the latest established point defined in the script
   - **Ignore and Continue** with the next test
   - **Abort Session**
Generate Reports

The QualiPHY software automates report generation. On the framework dialog, go to General Setup > Report to pre-configure reporting behavior. You can also manually launch the Report Generator from the framework dialog once a test is run.

The Report Generator offers the same selections as the Report tab, only applied to each report individually, rather than as a system setting. This enables you to save reports for each test session, rather than overwrite the generic report file. There are also options to link a custom style sheet (.xslt) to the report, or to Exclude Informative Results.

The Test Report includes a summary table with links to the detailed test result pages.

Reports are output to the folder D:\QPHY\Reports, or C:\LeCroy\QPHY\Reports if QualiPHY is installed on a remote PC.

You can add your own logo to the report by replacing the file QPHY\StyleSheets\CustomerLogo.jpg. The recommended maximum size is 250x100 pixels at 72 ppi, 16.7 million colors, 24 bits. Use the same file name and format.
Customizing QualiPHY

The pre-loaded configurations cannot be modified. However, you can create your own test configurations by copying one of the standard test configurations and modifying it.

Copy Configuration

1. Access the QualiPHY framework dialog and select a Standard.
2. Click Edit/View Configuration and select the configuration upon which to base the new configuration. This can be a pre-loaded configuration or another copy.
3. Click Copy and enter a name and description. Once a custom configuration is defined, it appears on the Configuration tab followed by “(Copy).”
4. Select the new, custom configuration and follow the procedures below to continue making changes.

   **Note:** If any part of a configuration is changed, the Save As button becomes active on the bottom of the dialog. If a custom configuration is changed, the Save button will also become active to apply the changes to the existing configuration, rather than create a new one.

Select Tests

On the Test Selector tab, select/deselect the tests that make up the configuration. Each test is defined by the 10GBase-KR standard. A description of each test is displayed when it is selected.

To loop any of the tests in this configuration, select the test from the list, then choose to loop indefinitely until stopped or enter the number of repetitions.
**Edit Variables**

The Variable Setup tab contains a list of test variables. See [QPHY-10GBASE-KR Variables](#) for a description of each.

To modify a variable:

1. Select the variable on the Variable Setup tab, then click **Edit Variable**. (You can also choose to Reset to Default at any time.)

2. The conditions of this variable appear on a pop-up. Choose the new condition to apply.

![Variable Setup tab](image)

*Figure 3. Variable Setup tab*
**Edit Test Limits**

The Limits tab shows the Limit Set currently associated with the configuration. Any limit set can be associated with a custom configuration by selecting it in this field.

The Limits Manager shows the settings for every test limit in a limit set. Those in the default set are the limits defined by the standard.

To create a custom limit set:

1. On the Limits tab, click **Limits Manager**.
2. With the default set selected, click **Copy Set** and enter a name.

   **Note:** You can also choose to copy and/or modify another custom set that has been associated with this configuration.

3. Double click the limit to be modified, and in the pop-up enter the new values.

You can also import limits from a .csv file. Navigate to the file location after clicking the button.

**Tip:** Likewise, Export Limits creates a .csv file from the current limit set. You may wish to do this and copy it to format the input .csv file.

![Figure 4. Limits Manager](image-url)
X-Replay Mode

The X-Replay mode window is an advanced (“developer”) view of QualiPHY. The tree in the upper-left frame enables you to navigate to processes in the 10GBase-KR test script, in case you need to review the code, which appears in the upper-right frame.

Two other particularly useful features are:

- **A list of recent test sessions** in the lower-left frame. While you can only generate a report of the current test session in the QualiPHY wizard, in X-Replay Mode you can generate a report for any of these recent sessions. Select the session and choose **Report > Create Report** from the menu bar.

- **An event log is shown** in the bottom-right frame. The frame can be split by dragging up the lower edge. The bottom half of the frame now shows the **raw Python output**, which can be useful if ever the script needs debugging.

![Figure 5. X-Replay Mode window](image-url)
QPHY-10GBASE-KR Testing

Test Preparation
Before beginning any data acquisition or test, warm the oscilloscope for at least 20 minutes.
Calibration is performed automatically by the oscilloscope software; no manual calibration is required.
The calibration procedure will be run again if the temperature of the oscilloscope changes by more than a few degrees.

QPHY-10GBASE-KR Test Configurations
Test configurations include variable settings, limit sets, and test selections. See QPHY-10GBASE-KR Variables for a description of each variable and its default value. See the QPHY-10GBASE-KR Limit Sets for more information about the default test limits.

DEMO Mode
This configuration performs a demonstration of all tests covered in QPHY-10GBase-KR using stored waveforms. The limit set in use is IEEE 802.3ap limits. All variables are set to their default settings except that Test Mode is set to Use Saved Data, Saved Waveform Path is set to D:\Waveforms\10GBaseKR\Demo, Demo Mode is set to Yes. The tests performed are:

- Jitter (Tj, Rj, Dj, DCD and Bit Rate)
- Voltage Measurements (Single ended)
- Transition Time Measurements
- Tx Equalization

Run Live with Pauses, Single Ended Inputs on row A
The configuration generates the specification-required measurements and eye diagram as described in section 72.7 of IEEE 802.3ap-2007. All variables are set to their default settings. The tests performed are:

- Jitter (Tj, Rj, Dj, DCD and Bit Rate)
- Voltage Measurements (single ended)
- Transition Time Measurements
- Tx Equalization
QPHY-10GBASE-KR Test Descriptions
These are the standard 10GBase-KR compliance tests.

Jitter: $T_j$, $R_j$, $D_j$, DCD & BitRate
This test measures all timing parameters that can be measured on a PRBS or scrambled data signal. The measurements are directly produced by SDAII or SDAIII.

Voltage Measurements Single Ended – on 0101
This test measures MaxDiffPPOutVoltage, MaxCommonMode and MinCommonMode, and DutyCycle. MaxCommonMode is 1.9V. The MinDiffCommonMode limit is -0.04 V, even though the spec is 0, so that readings within scope tolerance for DC accuracy will pass.

Voltage Measurements Differential – on 0101
This test measures MaxDiffPPOutVoltage and Duty Cycle. It is not possible to measure common mode voltage through a differential probe; the probe does its best to suppress common mode.

Transition Time Test
This test measures Rise 20%-80% and Fall 80%-20%. Results must be between 24 and 47ps.

TX Output Waveform Tests
See IEEE Std 802.3 sections:
- 72.7.1.10 Transmitter output waveform
- 72.7.1.11 Transmitter output waveform requirements (Table 72-8 and requirements that follow it, particularly)
  - TX EQ part 1: C(0) min, C(1) and C(-1) disabled
  - TX EQ part 2: C(0) max, C(1) and C(-1) disabled
  - TX EQ part 3: C(0) and C(1) min, C(-1) disabled
  - TX EQ part 4: C(0) and C(-1) min, C(1) disabled

In each of these sections several “level matching” requirements are checked, and the invariant requirements on “delta V2” and “delta V5” are checked.
**QPHY-10GBASE-KR Variables**

**Acquire Live Data**  
When set to “Yes,” runs tests on newly acquired data signals instead of using stored waveform files.

**Demo Mode**  
When Demo Mode is “On”, tests are run using saved waveform files that will be automatically recalled into memory by the script. The user will still be shown connection diagrams and prompts so as to experience running the tests as if on live data. Default is “Off.”

**Note:** Waveforms for this demo are stored internally in the QPHY-10GBASE-KR script file.

**Differential Signal Source**  
Specifies the differential source signal to be tested when "Signal Is Differential" is set to “True”. Valid settings include all input channels C1-Cn, memories M1-Mn, and Math functions F1-F4.

**Input Row**  
Specifies the input used in oscilloscopes with both low- and high-bandwidth inputs for a given channel. Input A (upper row) is the default.

**Save Waveform Path**  
Full path to the root folder in which waveform data will be saved, or if Acquire Live Data is “False”, the path from which previously stored waveform files will be recalled. The default assumes QualiPHY is run from the oscilloscope. If you are running QualiPHY remotely, be sure the directory is accessible to the oscilloscope and not “Read Only.”

**Note:** This path MUST end with a backslash \, as a subfolder of the same name as the DUT will be appended to the path.

**Save Waveforms**  
Specifies whether or not to store waveform files in the Save Waveform Path directory.

**Signal Is Differential**  
Specifies whether or not the input signal is differential. If “False”, the oscilloscope will calculate the difference between single-ended Signal Source P and Signal Source N to serve as the differential signal.

**Signal Source N**  
Specifies the negative input of a pair of single-ended signals. The default is C3.

**Signal Source P**  
Specifies the positive input of a pair of single-ended signals. The default is C2.

**Stop on Test**  
Specifies whether or not to stop the test each time results are saved so they can be reviewed by the user. If “Yes”, the user will be prompted to continue the test after each pause.

**Specific to Jitter and Voltage Tests**

**Test Pattern for Jitter**  
Choose the pattern to use for jitter measurements. Patterns 1 and 2 are short enough to treat as a repeating pattern. Pattern 3, PRBS-31, is treated as a non-repeating pattern. Default is Pattern 1 or 2.
QPHY-10GBASE-KR Limit Sets

The default installation of QPHY-10GBASE-KR contains only one test limit set, called “Default.” In this script, limits are only used to convey Unit labels. The actual limits for each value tested are encoded in or computed by the script and cannot be changed. The default limits used by QPHY-10GBASE-KR are specified in IEEE 802.3ap-2007.
Appendix A: Manual Deskewing Procedures
This section applies only to the oscilloscope and the cables connecting to the oscilloscope channels.

Cable Deskewing Using the Fast Edge Output
The following procedure demonstrates how to manually deskew two oscilloscope channels and cables using the fast edge output, with no need for any T connector or adapters.

**Note:** Fast Edge output is available only on some models. If your oscilloscope does not have Fast Edge output, see Cable Deskewing Without Using the Fast Edge Output.

This can be done once the temperature of the oscilloscope is stable. The oscilloscope must be warmed up for at least a half-hour before proceeding. This procedure should be run again if the temperature of the oscilloscope changes by more than a few degrees.

For the purpose of this procedure, the two channels being deskewed are referred to as Channel X and Channel Y. The reference channel is Channel X and the channel being deskewed is Channel Y.

1. Begin by recalling the Default Oscilloscope Setup.
2. Configure the oscilloscope as follows:
   - **Timebase**
     i. Fixed Sample Rate
     ii. Set the Sample Rate to 40 GS/s
     iii. Set the Time/Division to 1 ns/div
   - **Channels**
     i. Turn on Channel X and Channel Y.
     ii. Set V/div for Channel X and Channel Y to 100mV/div.
     iii. Set the Averaging of Channel X and Channel Y to 500 sweeps.
     iv. Set the Interpolation of Channel X and Channel Y to Sinx/x.
• Trigger
  i. Configure to **Source** to be **FastEdge**.
  ii. Set the **Slope** to **Positive**.

• Parameter Measurements:
  i. Set the **source** for P1 to CX and the **measure** to Delay.
  ii. Set the **source** for P2 to CY and the **measure** to Delay.
  iii. Set the **source** for P3 to M1 and the **measure** to Delay.

3. Set the display to Single Grid by choosing **Display → Single Grid** from the menu bar.
4. Using the appropriate adapter, connect Channel X to the Fast Edge Output of the oscilloscope.
5. Adjust the Trigger Delay so that the Channel X signal crosses at the center of the screen.
6. Change the **Timebase** to 50 ps/div.

7. Fine tune the Trigger Delay so that the Channel X signal crosses at the exact center of the screen.
8. Press the **Clear Sweeps** button on the front panel to reset the averaging.
9. Allow multiple acquisitions to occur until the waveform is stable on the screen.
10. Save Channel X to M1.
   • Click **File → Save Waveform**.
   • Set **Save To Memory**.
   • Set the **Source** to CX.
   • Set the **Destination** to M1.
   • Click **Save Now**.

11. Disconnect Channel X from the Fast Edge Output and connect Channel Y to the Fast Edge Output.

12. Press the **Clear Sweeps** button on the front panel to reset the averaging.

13. Allow multiple acquisitions to occur until the waveform is stable on the screen.

14. From the Channel Y menu, adjust the **Deskew** of Channel Y until Channel Y is directly over the M1 trace.

15. Ensure that P3 and P2 are reasonably close to the same value. (Typically < 5ps difference)
Cable Deskewing Without Using the Fast Edge Output

The following procedure demonstrates how to manually deskew two oscilloscope channels and cables using the differential data signal, with no need for any T connector or adapters.

This can be done once the temperature of the oscilloscope is stable. The oscilloscope must be warmed up for at least a half-hour before proceeding. This procedure should be run again if the temperature of the oscilloscope changes by more than a few degrees.

1. Connect a differential data signal to C1 and C2 using two approximately matching cables. Set up the oscilloscope to use the maximum sample rate. Set the timebase for a few repetitions of the pattern (at least a few dozen edges).

2. On the C3 menu, check Invert. Now C1 and C2 should look the same.

3. Using the Measure Setup, set P1 to measure the Skew of C1, C2. Turn on Statistics (Measure menu). Write down the mean skew value after it stabilizes. This mean skew value is the addition of Data skew + cable skew + channel skew.

4. Swap the cable connections on the Data source side (on the test fixture), and then press the Clear Sweeps button on the oscilloscope (to clear the accumulated statistics; since we changed the input).

5. Write down the mean skew value after it stabilizes. This mean skew value is the addition of (-Data skew) + cable skew + channel skew.

6. Add the two mean skew values and divide the sum in half:

\[
\frac{[\text{Data skew} + \text{cable skew} + \text{channel skew}] + [(-\text{Data skew}) + \text{cable skew} + \text{channel skew}]}{2}
\]

The above formula simplifies to:

\[
[\text{cable skew} + \text{channel skew}]
\]

7. Set the resulting value as the Deskew value in C1 menu.

8. Restore the cable connections to their Step 1 settings (previous). Press the Clear Sweeps button on the oscilloscope. The mean skew value should be approximately zero - that is the data skew. Typically, results are <1ps given a test fixture meant to minimize skew on the differential pair.

9. On the C2 menu, clear the Invert checkbox and turn off the parameters.
In the previous procedure, we used the default setup of the Skew parameter (which is detecting positive edges on both signals at 50%). We also inverted C2 in order to make C1 and C2 both have positive edges at the same time.

Alternately, we clearly could have not inverted C2 and instead selected the Skew clock 2 tab in the P1 parameter menu and set the oscilloscope to look for negative edges on the second input (C2). However, we believe that the previous procedure looks much more aesthetically pleasing from the display as it shows C2 and C3 with the same polarity.